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SCC-CTRO1 Isolated
Counter/Timer 1/0 Module

The SCC-CTRO1 is a two input and one output isolation module for
general-purpose counter/timers on DAQ devices. The gate and source
inputs are optically isolated to allow an increased voltage range and protect
against common-mode voltages. The inputs also have reverse and
overvoltage protection. The output channel is isolated and has advanced
short-circuit protection, which allows the circuit to recover automatically
250 ms after a short is removed.

Conventions

The following conventions are used in this guide:

» The » symbol leads you through nested menu items and dialog box options
to a final action. The sequence File»Page Setup»Options directs you to
pull down the File menu, select the Page Setup item, and select Options
from the last dialog box.

This icon denotes a caution, which advises you of precautions to take to
avoid injury, data loss, or a system crash. When this symbol is marked on
the product, refer to the Read Me First: Safety and Radio-Frequency
Interference document, shipped with the product, for precautions to take.

This icon denotes a note, which alerts you to important information.
take precautions to avoid electrical shock.

When symbol is marked on a product, it denotes a component that may be

ﬁ When symbol is marked on a product, it denotes a warning advising you to
& hot. Touching this component may result in bodily injury.

bold Bold text denotes items that you must select in software, such as menu
items and dialog box options. Bold text also denotes parameter names.
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italic

monospace

SC-2345

SCC

Ttalic text denotes variables, emphasis, a cross reference, or an introduction
to a key concept. Italic text also denotes text that is a placeholder for a word
or value that you must supply.

Text in this font denotes text or characters that you should enter from the
keyboard, sections of code, programming examples, and syntax examples.
This font is also used for the proper names of disk drives, paths, directories,
programs, subprograms, subroutines, device names, functions, operations,
variables, filenames, and extensions.

SC-2345 refers to both the SC-2345 connector block and the SC-2345 with
configurable connectors.

SCC refers to any SCC Series signal-conditioning module.

What You Need to Get Started

To set up and use the SCC-CTRO1, you need the following items:

L SC-2345 with one of the following:
- SCC-PWRO1
—  SCC-PWRO02 and the PSO1 power supply
—  SCC-PWRO03 (requires a 7 to 42 VDC power supply, not included)

One or more SCC-CTRO1 modules

SC-2345/2350 Carrier User Manual, available at ni . com
SCC-CTROI Isolated Counter/Timer I/O Module User Guide
SCC Quick Start Guide, available at ni . com

Read Me First: Safety and Radio-Frequency Interference

SC-2345 Quick Reference Label

(I U I S S SR

68-pin E/M Series DAQ device with the following:
—  Documentation

—  68-pin cable of less than 2 m length
1/8 in. flathead screwdriver

Numbers 1 and 2 Phillips screwdrivers
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U Wire insulation strippers

U NI-DAQ (current version) for Windows 2000/NT/XP/Me

E Note Mac OS is not supported.

Device-Specific Information

E Note For general SCC module installation and signal connection information, and
information about the SC-2345 carrier, refer to the SCC Quick Start Guide, available
for download at ni.com/manuals.

Installing the Module

A Caution Refer to the Read Me First: Safety and Radio-Frequency Interference document
before removing equipment covers or connecting/disconnecting any signal wires.

E Note When using the module with a PXI/PCI chassis, E/M Series DAQ device, and an
SC-2345 carrier, the SCC-CTRO1 should be grounded.

Plug the SCC-CTRO1 into either general-purpose counter/timer socket J19
or J20 on the SC-2345. When you configure the SC-2345 according to the
procedure in the SCC Quick Start Guide, the SC-2345 routes the
CTR_SRC, CTR_GATE, and CTR_OUT signals through the module.

Connecting Signals and Loads to the SCC-CTRO1

Inputs (Gate and Source)

The inputs on the SCC-CTRO1 are referenced to either the ground or the
supply of the external device to which they are connected. An optical
isolator transfers the externally connected signals to the internal
GPCTR SRC or GATE. A current limiter protects the optical isolator.

A diode protects against reverse-connected signals.
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Figure 1 illustrates a single isolated input.
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Figure 1. Single Isolated Input

Inputs are referenced to either the ground or supply of the external device,
depending on whether or not the external device can source the amount of
current required by the SCC-CTROLI input circuitry. To guarantee a digital
HIGH, the minimum amount of current required by the SCC-CTRO1 inputs
is 2.2 mA. The overvoltage and overcurrent protector does not allow the
amount of current flowing through the input circuitry to exceed 10 mA.

Connecting the SCC-CTRO1

The following sections describe how to connect the SCC-CTRO1 as
referenced to ground and as referenced to the supply.

Connecting the SCC-CTRO1 as Referenced to Ground

Connect the external device to the SRC or GATE + pin, and connect the
device ground to the SRC or GATE — pin, as shown in Figure 2.
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SRC or
GATE +

@ SRC or
GATE -
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Figure 2. Referenced to Ground

Connecting the SCC-CTRO1 as Referenced to the

Supply

Connect the V4 on the external device to the SCC-CTR0O1 SRC or GATE +
pin, and connect the output of the external device to the SRC or GATE —
pin, as shown in Figure 3.

@ SRC or
GATE +

SRC or
GATE -

VSS or GND

1SCC-CTRO1

Figure 3. Referenced to Supply

@ Note Connecting the SCC-CTRO1 as referenced to the supply reverses the digital logic.
To operate the SCC-CTRO1 with TTL devices, reference the SCC-CTRO1 to the supply, as

shown in Figure 3.

@ Note When placing a relatively slow rise time signal—such as a 5V peak sine or triangle
wave—on one of the inputs, and a fast rise time, high voltage signal—such as a 400 kHz,
48 V square wave—on the other input, crosstalk between input lines can cause false
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triggering. You should separate the input wires as much as possible. If you are using an
M Series DAQ device, consult the device documentation for information about applying
the appropriate digital filter to prevent incorrect measurements.

Outputs

The outputs on the SCC-CTRO1 consist of N-channel MOSFETs that are
connected as low-side switches. A Schottky diode blocks reverse current
flow.

Figure 4 illustrates an SCC-CTROI isolated output.
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Figure 4. Connecting an SCC-CTRO1 Isolated Output

For the output circuit to function, you must provide 5 to 48 V between V g4
and V. Reverse connections of V3 and V¢ do not damage the circuit as
long as these connections do not exceed 60 VDC, as listed in the
Specifications section.

If the amount of current the MOSFET conducts exceeds a certain level
(800 mA, typical)—such as when a short occurs in the load—the
MOSFET turns off for 250 ms to protect itself and the load. After this
period of time, the output tries to switch on. If the short still exists, it turns
off for another 250 ms. This process continues until the overcurrent or short
condition is removed, after which switching automatically resumes.
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Note Add bypass capacitor(s) between Vg and V, at the load to reduce the chances of
ringing when the output switches on and off, especially when the connecting wires are
longer than 2 m.

Note For most DAQ device counters, the default state is LOW, which results in the output
MOSFET being switched to ON. If you want to change the default state—for example, to
eliminate continuous power dissipation in the load during the idle state—you should
consult your DAQ documentation for information about how to change the default to
HIGH and switch the MOSFET to OFF.

Driving Inductive Loads

AN\

Caution When the output of the SCC-CTRO1 is used to drive an inductive load, high
voltages will appear suddenly because of the current switching through the inductor. To
prevent these high voltages from causing damage to the output circuit or the load, add
flyback diodes across your inductive load, as shown in Figure 5.

Flyback
Diode

Figure 5. Flyback Diodes on Inductive Load

Caution Ensure the diode you choose is capable of handling the amount of current the load
is holding when the output is ON.
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Theory of Operation

Input (Source and Gate)

Optical Isolation

The gate and source inputs are isolated from each other and from the
SCC-CTRO1 internal power and ground signals. The isolation barrier
protects the SCC-CTRO1 and other equipment from voltages up to

60 VDC. Common-mode voltages higher than 60 VDC can damage the
SCC-CTRO1 and other equipment. The isolation allows for increased input
ranges. The input signal can be varied between 0 VDC and 48 VDC
between the + and — terminals. The isolation also protects against ground
loops.

Reverse and Over-voltage Protection

A diode placed between the + and — input terminals provides reverse
voltage protection to the SCC-CTRO1 and other equipment. In addition, the
SCC-CTRO1 is equipped with overvoltage protection and can handle
continuous voltages, between the + and — input terminals, up to +60 VDC.

Frequencies of Operation

Based on the application, the SCC-CTRO1 may operate at higher than the
maximum frequency specified in the Specifications section. Table 1 lists
the typical SCC-CTRO1 input channel operating rates.

Table 1. SCC-CTRO1 Typical Input Tasks Maximum Rates

Pulse Width Period
Measurement, Measurement,
Operating Counting Semi-Period Frequency Position
Voltage Edges Measurement Measurement Measurement
5V 1 MHz 0.6 ps 1 MHz 1 MHz
24V 800 kHz 1 us 800 kHz 800 kHz
48V 400 kHz 1 us 400 kHz 400 kHz

Notes: Typical at 25 °C, 1 meter cable connected to DAQ device.

Measurement accuracy can be improved by adjusting the LOW to HIGH and HIGH to LOW switching times in the software.
Refer to the Theory of Operation section for more information.
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Output (Out)

Signal Isolation

The output is isolated from the inputs, and the SCC-CTRO1 internal power
and ground signals. The isolation barrier protects the SCC-CTRO01 and
other equipment from voltages up to 60 VDC. Common-mode voltages
higher than 60 VDC can damage the SCC-CTRO1 and other equipment.

Increased Range

The voltage range of the output is increased by providing the user access to
the power terminals V44 and V. The user can safely provide 5 to 48 VDC
allowing equal scaling of the output.

Current Limited (Short Circuit Protection)

The SCC-CTRO1 has advanced short circuit protection. The output is
automatically turned off if the output current exceeds a certain limit
(800 mA typical, 1.1 A max). The SCC-CTRO1 tries to reoperate every
250 ms and automatically recovers after the short is removed.

Reverse and Overvoltage Protection

The SCC-CTRO1 provides protection for voltages up to +60 VDC between
V44 and Vg and the output and V.

Frequencies of Operation

Based on the application, the SCC-CTRO1 may operate at higher than the
maximum frequency specified in the Specifications section. Table 2 lists
typical SCC-CTRO1 output channel rates.

Table 2. SCC-CTR01 Output Tasks

Operating Frequency Pulse
Voltage Generation Generation
5V 600 kHz 1 ps
24V 500 kHz 1 ps
48V 400 kHz 1 us

Notes: Typical at 25 °C, 250 Q load, 1 meter cable connected to DAQ device.

Measurement accuracy can be improved by adjusting the ON and OFF switching times in
the software. Refer to the Theory of Operation section for more information.
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Using the SCC-CTRO1

The SCC-CTRO1 is functional in a variety of applications including
counting events; pulse width, period, semi-period, position, and frequency
measurements; and frequency, pulse, and pulse train generation.

The variation between the LOW to HIGH and the HIGH to LOW
propagation delays on the input channels may affect semi-period or
pulse-width measurements. Adjusting the measurement by the difference
between the LOW to HIGH and the HIGH to LOW propagation delays
(typically 30 ns at 5 V operation) minimizes this effect, as illustrated by the
following equation for a positive pulse in positive logic:

Adjusted Pulse Width = Actual Measurement + (LOW to HIGH Delay — HIGH to LOW Delay).
Example:

If using typical LOW to HIGH and HIGH to LOW propagation
delays/relays (180 ns and 150 ns), and the actual measured pulse width is
820 ns, then

Adjusted Pulse Width = 820 ns + (180 ns — 150 ns) = 820 ns.

The variation between the switching times on the output channel can affect
duty cycle generation. Adjusting the output by the difference between the
LOW to HIGH (220 ns) time and the HIGH to LOW time (120 ns)
minimizes this effect.

Adjusted Duty Cycle = Desired Duty Cycle + (LowtoHigh — High to Low Time) X Frequency of Generation.

Example:

While using the typical LOW to HIGH and HIGH to LOW times, if the
actual desired duty cycle is 0.50 at 400 kHz then:

Adjusted Duty Cycle = 0.50 + (150 ns — 500 ns) x 400 kHz = 0.36.
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Specifications

These specifications are typical at 25 °C unless otherwise stated.

Power
Power requirement ...........ccccceveeeeneennen. 140 mW max from +5 V rail
(digital power)
Isolated Inputs
Number of input channels...................... 2 (CTR_SRC, CTR_GATE)
INPUL LYPE .o Driven reference to either supply
or ground (two terminals per
input)
Maximum input frequency.........c..cc....... 400 kHz
Minimum input pulse width................... 1 us

Input-to-input, input-to-output,

and input-to-PC ground isolation........... 60 VDC, continuous, verified by a
620 Vrms dielectric withstand
test, 5 sec

Input waveform types......c..cccceeeeveereenne. Any

Voltage

Voltage range .......ccccceceeeveeeeceeneevecneene. Up to 48 VDC

Typical ON voltage........cccceeveerereenuennee. 25V

Guaranteed ON voltage.........ccoccevuenueeee. 4V

Guaranteed OFF voltage ........c..ccccueenee. 0.8V

Current

ON State CUITENt ..eeveveeeeeeeeeeeeeeeeeeeeeeeens 2.2 mA min, 6 mA typ,
10 mA max

OFF state Current........eeeeeeveneenuenneenne 0.1 mA max
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Isolated Output

Protection

Current Hmit ....ooeeveeveeneenenennienenienene 10 mA max (over operating
temperature range)

Reverse and overvoltage...........c..cccc..e. +60 VDC max, continuous

Propagation Delays (for a 5 V Input Signal)

LOW to HIGH .....cccooiiiiiiniiicnieicee 180 ns typ

HIGH to LOW ...couiiiiiiiiiecieeeeee 150 ns typ

Number of output channels..................... 1 (CTR_OUT)

OULPUL LYPE et Sinking (low-side switch)

Output power requirement...............c...... 5t0 48 VDC (10 mA per channel,
typical at 400 kHz)

Load voltage range ..........cceeeveeeenuennnee 5to 48 VDC

Switching current.........ccecevereeeneniennene 100 mA, max

Inrush current..........ccccoeeeeviiieeeeiiiiineeenn, 600 mA, max

Maximum output frequency ................... 400 kHz

Minimum output pulse width ................. 1 us

Output-to-output, output-to-input,

and output-to-PC ground isolation ......... 60 VDC peak, continuous,
verified by a 620 Vrms dielectric
withstand test, 5 sec

Typical switching times (with a 5 V, 100 Q load)

LOW to HIGH........ccccocevieiinine 150 ns
HIGH to LOW ...c.ooeviniiniiniiinienns 500 ns
Output LOW maximum voltage ............ 0.47 V at 10 mA,

0.75 V at 100 mA

Output leakage current when OFF.......... 60 LA max
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Protection

Short circuit (on output pins) ................. 0.6 A min, 1.1 A max
(stays off after detecting a short
circuit and retries to operate every
250 ms, then automatically
recovers after removing the short)

Reverse and overvoltage

on output and Vg pins ....cccceceeveereeneennene +60 VDC max, continuous

Physical Characteristics
Dimensions.........cccceeevveeeeeeecinieeeeeennen. 8.89cm x2.92cmx 1.85 cm
(3.50 in. x 1.15 in. X 0.73 in.)
MASS .ottt 28.6 g (1.0 02)

I/0O coNNectors ......ceveerveeceeeniierieeiieeen One 20-pin right-angle
male connector,
one 7-pin screw terminal

Field-wiring diameter............cccccoceeneeee. 28 to 16 AWG
Environmental

Operating temperature............cecceeeeeveenee. 0to 50 °C

Storage temperature ...........ccccoeeveeuenneee —20to 70 °C

Humidity «..oooovevvenviieiiiciieenceceeene 10 to 90% RH, noncondensing

Maximum altitude ...........ooovvvvveveiininnnns 2,000 m

Pollution Degree (indoor use only)........ 2

Safety

The SCC-CTRO1 meets the requirements of the following standards
of safety for electrical equipment for measurement, control, and
laboratory use:

« JEC61010-1,EN 61010-1
« UL 61010-1
* CAN/CSA-C22.2 No. 61010-1

@ Note For UL and other safety certifications, refer to the product label, or visit
ni.com/certification, search by model number or product line, and click the
appropriate link in the Certification column.
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Electromagnetic Compatibility

EmiSSiONS...ccuvvveiieiiiieeeeeeiiieee e EN 55011 Class A at 10 m
FCC Part 15A above 1 GHz

IMMUNILY oo EN 61326:1997 + A2:2001,
Table 1

CE, C-Tick, and FCC Part 15 (Class A) Compliant

@ Note For full EMC compliance, operate this device with shielded cabling.

CE Compliance

This product meets the essential requirements of applicable European
Directives, as amended for CE marking, as follows:

Low-Voltage Directive (safety).............. 73/23/EEC

Electromagnetic Compatibility
Directive (EMC)......coceoieviniiiininicene 89/336/EEC

&

Note You must ground the system hosting your DAQ device to meet regulatory emission
requirements.

&

Note Refer to the Declaration of Conformity (DoC) for this product for any additional
regulatory compliance information. To obtain the DoC for this product, visit
ni.com/certification, search by model number or product line, and click the
appropriate link in the Certification column.
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SCC-SCTRO1 Module Pin Assignments

Figure 6 shows the I/O connector on the bottom of the SCC-CTRO1.

/@

000000000
0000000000 @
1 Pin1 2 Pin2 3 PWB Key 4 Pin19 5 Pin 20

Figure 6. SCC Module, Bottom View
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Table 3 lists the signal connection corresponding to each pin. GND is the

reference for the +5 V supply.

Table 3. SCC-CTRO1 Pin Signal Connections

Pin Number J19-J20: GPCTR 0 J19-J20: GPCTR 1
1 CTR 0 OUT CTR 1 OUT
2 J— J—
3 PFI 9/CTR 0 GATE PFI 4/CTR 1 GATE
4 _ _
5 PFI 8/CTR 0 SOURCE PFI 3/CTR 1 SOURCE
6 J— J—
7 _ _
8 J— J—
9 +5V +5V
10 GND GND
11 — —
12 — —
13 — —
14 — —
15 — —
16 — —
17 — —
18 — —
19 — —
20 — —
National Instruments, NI, ni.com, and LabVIEW are trademarks of National Instruments Corporation.
Refer to the Terms of Use section on ni . com/legal for more information about National
Instruments trademarks. Other product and company names mentioned herein are trademarks or trade
names of their respective companies. For patents covering National Instruments products, refer to the
appropriate location: Help»Patents in your software, the patents . txt file on your CD, or
ni.com/patents.
© 2005 National Instruments Corporation. Al rights reserved. 371673A-01 Sep05
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